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Tips for Creating Accessible Documents in Microsoft Word and 
Google Docs 

Creating Accessible Documents in Microsoft Word 

Taken from https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-
people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d  

Microsoft Word and Google Docs are widely used applications for creating text documents. The 
text within documents can be read with screen readers, making it more accessible for individuals 
with disabilities. 

Windows/MacOS 

1. Check accessibility while you work in Word 

2. Avoid using tables 

3. Use built-in title, subtitle, and heading styles 

4. Create paragraph banners 

5. Add alt text to visuals 

6. Add accessible hyperlink text and ScreenTips 

7. Use accessible font format and color 

8. Create accessible lists 

9. Adjust space between sentences and paragraphs 

10. Test accessibility with Immersive Reader 

Run the Accessibility Checker 

The MS Word Accessibility Checker will check the document for common accessibility issues. 
The Accessibility Checker provides suggestions about how to fix any issues found in your 
document. 

MS Word Accessibility Checker (link is external) 

Use heading styles 

Heading styles make it easier for assistive technology (AT) users to navigate your documents. 
Each heading style represents a different level in the content hierarchy and communicates the 
structure of your document to AT users. 

Apply MS Word Heading Styles: 

● Windows heading styles (link is external) 

● Mac OS heading styles (link is external) 

https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://support.office.com/en-us/article/use-the-accessibility-checker-to-find-accessibility-issues-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d?ui=en-us&rs=en-us&ad=us#bkmk_builtinheadings_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d?ui=en-us&rs=en-us&ad=us#bkmk_builtinheadings_mac


Use alternative text for images 

Alternative text is a short description of an image in your document. The “alt-text” will be read by 
users of assistive technology who would not otherwise know the content of the image. 

Add MS Word Alternative Text: 

● Windows alt text (link is external) 

● Mac OS alt text (link is external) 

Avoid using tables 

In general, avoid tables if possible and present the data another way, like paragraphs with 
headings and banners. Tables with fixed width might prove difficult to read for people who use 
Magnifier, because such tables force the content to a specific size. This makes the font very 
small, which forces Magnifier users to scroll horizontally, especially on mobile devices. 

If you have to use tables, use the following guidelines to make sure your table is as accessible as 
possible: 

● Avoid fixed width tables. 

● Make sure the tables render properly on all devices, including phones and tablets. 

● If you have hyperlinks in your table, edit the link texts, so they make sense and don't 

break mid-sentence. 

● Make sure the document is easily read with Magnifier. Send the document draft to 

yourself and view it on a mobile device to make sure people won’t need to horizontally 

scroll the document on a phone, for example. 

Use table headers 

Ideally, headings explain what a document section is about. Use the built-in heading styles and 
create descriptive heading texts to make it easier for screen reader users to determine the 
structure of the document and navigate the headings. 

Each heading style represents a different level in the content hierarchy and communicates the 
structure of your document to AT users. 

Use MS Word Table Headers: 

● Windows table headers (link is external) 

● Mac OS table headers (link is external) 

Create paragraph banners 

In addition to using headings to organize the content in your document, you can also create 
paragraph banners. In a paragraph banner, the background color block extends across the width 
of the document and highlights the text within the banner. This is a great alternative to tables to 
organize and separate content. 

For instructions on how to create paragraph banners, go to Apply shading to words or 
paragraphs. 

https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_altvisuals_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d?ui=en-us&rs=en-us&ad=us#bkmk_altvisualso365_mac
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_tableheaders_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d?ui=en-us&rs=en-us&ad=us#bkmk_mactableheaders
https://support.microsoft.com/en-us/office/apply-shading-to-words-or-paragraphs-2020d0e0-f99e-4d53-a895-009077cbcfda
https://support.microsoft.com/en-us/office/apply-shading-to-words-or-paragraphs-2020d0e0-f99e-4d53-a895-009077cbcfda


Add accessible hyperlink text and ScreenTips 

People who use screen readers sometimes scan a list of links. Links should convey clear and 
accurate information about the destination. 

For example, avoid using link texts such as "Click here," "See this page," Go here," or "Learn 
more." Instead include the full title of the destination page. You can also add ScreenTips that 
appear when your cursor hovers over text or images that include a hyperlink. 

For the step-by-step instructions on how to create accessible hyperlinks and ScreenTips, go to 
Create accessible links in Word and Create or edit a hyperlink. 

Use accessible font format and color 

Use accessible font format 

Here are some ideas to consider: 

● To reduce the reading load, select familiar sans serif fonts such as Arial or Calibri. Avoid 

using all capital letters and excessive italics or underlines. 

● A person with a vision disability might miss out on the meaning conveyed by particular 

colors. For example, add an underline to color-coded hyperlink text so that people who 

are colorblind know that the text is linked even if they can’t see the color. 

● For headings, consider adding bold or using a larger font. 

● Add shapes if color is used to indicate status. For example, add a checkmark symbol  

 if green is used to indicate “pass” and an uppercase X   if red indicates 

“fail.” 

 

Use the color contrast analyzer  

The text in your document should be readable in a high contrast mode. For example, use bright 
colors or high-contrast color schemes on opposite ends of the color spectrum. White and black 
schemes make it easier for people who are colorblind to distinguish text and shapes. 

To ensure that text displays well in a high contrast mode, use the Automatic setting for font colors. 
For instructions on how to change the font color in Word, go to Change the font color. 

Sufficient color contrast makes text more accessible to individuals with color blindness. Ensure 
that the contrast ratio between the foreground and background colors meets the contrast 
requirements of WCAG 2.0 (link is external). 

Color Contrast Analyser (link is external) 

Create accessible lists 

To make it easier for screen readers to read your document, organize the information in your 
document into small chunks such as bulleted or numbered lists. 

Design lists so that you do not need to add a plain paragraph without a bullet or number to the 
middle of a list. If your list is broken up by a plain paragraph, some screen readers might 
announce the number of list items wrong. Also, the user might hear in the middle of the list that 
they are leaving the list.  

https://support.microsoft.com/en-us/office/video-create-accessible-links-in-word-28305cc8-3be2-417c-a313-dc22082d1ee0
https://support.microsoft.com/en-us/office/create-or-edit-a-hyperlink-5d8c0804-f998-4143-86b1-1199735e07bf
https://support.microsoft.com/en-us/office/change-the-font-color-37484b84-1605-48fc-8771-366913e5700c
https://www.w3.org/TR/WCAG20/#visual-audio-contrast-contrast
https://www.w3.org/TR/WCAG20/#visual-audio-contrast-contrast
https://www.tpgi.com/color-contrast-checker/


Adjust space between sentences and paragraphs 

People who have dyslexia describe seeing text “swim together” on a page (the compressing of 
one line of text into the line below). They often see text merge or distort. To reduce the reading 
load, you can increase white space between sentences and paragraphs. 

For the step-by-step instructions on adjusting the spacing, go to Adjust indents and spacing in 
Word. 

Test accessibility with Immersive Reader 

Try reading the document with Immersive Reader to check how it sounds like. 

1. In your document, select View > Immersive Reader. 

2. On the Immersive Reader tab, select Read Aloud. 

3. To exit Immersive Reader, select Close Immersive Reader. 

 

Creating Accessible Documents in Google Docs 

Taken from https://support.google.com/docs/answer/6199477?hl=en 

1. Use headings to organize your document 

2. Include alt text 

3. Check for high color contrast 

4. Use numbered and bulleted lists 

5. Include navigation landmarks in your document 

6. Use informative link text 

7. Use text size and alignment 

8. Use text to support formatting 

9. Use tables for data, not for layout 

10. Use Comments and Suggestions 

11. Present slides with captions 

12. Share a link to the HTML view of your presentation 

13. Use “Publish to the Web” Function 

When you create a document or presentation, follow the tips below to make it more readable by 
everyone, including people with disabilities. 

Use headings to organize your document 

Headings divide your document into sections, making it easier for people to jump to a section 
(especially if they’re using keyboard shortcuts). You can use the default heading styles or create 
your own. Learn how to add and customize headings. 

https://support.microsoft.com/en-us/office/adjust-indents-and-spacing-in-word-dd821599-b731-4c29-be3c-d854a705e086#ID0EBBD=Windows
https://support.microsoft.com/en-us/office/adjust-indents-and-spacing-in-word-dd821599-b731-4c29-be3c-d854a705e086#ID0EBBD=Windows
https://support.google.com/docs/answer/6199477?hl=en
https://support.google.com/docs/answer/116338


Include alt text 

Alternative text for images, drawings, and other graphics provides screen reader users with an 
audio description of what’s on screen. Otherwise, a user only hears the word "image" and could 
miss any relevant visual details.   

Always provide alt text for any visual data if there are no other text annotations. Some images 
automatically include alt text. It's a good idea to verify that the automatic alt text is correct. 

Add or edit alt text 

1. Select an image, drawing, or graphic. 

2. Use one of the following options:  

1. Right click and select Alt text. 

2. For Mac: Press ⌘ + Option + y. 

3. For all other platforms: Press Ctrl + Alt + y. 

3. Enter a title and description 

4. Click Ok. 

Check for high color contrast 

High color contrast makes text and images easier to read and comprehend. Web Content 
Accessibility Guidelines (WCAG) 2.0 recommend a minimum ratio of 4.5:1 for large text and 7:1 
for other text and images. For example, avoid light gray text on a white background. 

To check contrast, use one of these tools: 

● WebAIM contrast checker: This is a website that allows you to enter Pantone and font 

data to get a pass/fail rating based on WCAG 2.1 compliance.  

● Accessible Web Color Contrast Checker: This is a website that allows you to enter color 

values to check contrast. 

Use numbered and bulleted lists 

Google Docs and Google Slides automatically detect and format some lists for accessibility. For 
example, if you start a new line in your document by typing the number 1 followed by a period, the 
new line automatically becomes the first item in a numbered list. Learn how to format bulleted and 
numbered lists. 

Include navigation landmarks in your document 

Landmarks like headers, footers, page numbers, and page counts help your readers find where 
they are in your document. To maximize accessibility, especially in long documents, include one 
or more of these landmarks (available in the Insert menu). 

 

 

https://www.w3.org/TR/WCAG20/#visual-audio-contrast
https://www.w3.org/TR/WCAG20/#visual-audio-contrast
http://webaim.org/resources/contrastchecker/
https://accessibleweb.com/color-contrast-checker/
https://support.google.com/docs/answer/3300615
https://support.google.com/docs/answer/3300615
https://support.google.com/docs/answer/86629


Use informative link text 

Screen readers can scan for links, so informative link text is helpful. It's best to use the title of the 
page as the linked text. For example, if you link to your profile page, the linked text should say 
"my profile," not "click here." 

Check text size and alignment 

To make your document or presentation easy to read, use large, left-aligned text when possible. 
Justified text is more difficult to read because of extra space between the words. To change the 
alignment, press Ctrl + Shift + L (Windows or Chrome OS) or ⌘ + Shift + L (Mac). 

Use text to support formatting 

It's best not to rely on visual formatting alone to communicate meaning. Screen readers might not 
announce formatting changes, such as boldface or highlighting. 

For example, to mark an important section of text, add the word "Important." 

Use tables for data 

Use tables to present data, not to change the visual layout of the page. In the table, include a 
heading row rather than start with data in the first row. 

Use comments and suggestions 

Use the commenting and suggesting features instead of writing notes within the text of your 
document or presentation. Screen reader users can jump to comments using keyboard shortcuts 
rather than hunting through your file. The file owner can also receive email notifications or review 
comment threads. 

Using Google Slides 

Present slides with captions 

When you present with Google Slides, you can turn on automatic captions to display the 
speaker's words in real time at the bottom of the screen. Learn how to present slides with 
captions. 

Share a link to the HTML view of your presentation 

The Google Slides HTML view displays your entire presentation in a single, scrollable HTML 
page, instead of one slide at a time. For some screen reader users, HTML pages can be easier to 
navigate.  

To share a link to the HTML view of your presentation: 

1. Use the keyboard shortcut Ctrl + Alt + Shift + p (Windows or Chrome OS) or ⌘ + 

Option + Shift + p (Mac). 

2.  Copy and paste the URL from your browser. 

Publish to the web 

https://support.google.com/docs/answer/65129
https://support.google.com/docs/answer/6033474
https://support.google.com/docs/answer/9109474
https://support.google.com/docs/answer/9109474


When a document, spreadsheet, or presentation is published to the web, the published content is 
viewable as a single, scrollable HTML page. Screen reader users often find the HTML version 
easier to read. 

Based on your account’s settings, when you publish a file, you can make it visible to: 

● Everyone on the web 

● Everyone in your organization 

● A group of people in your organization 

Learn how to publish to the web. 

  

https://support.google.com/docs/answer/183965


Tips for Creating Accessible PDF Documents 

https://webaccess.berkeley.edu/resources/tips/pdfs 

● It is recommended to use Microsoft Word or Adobe InDesign to create your PDF 

documents, as these programs allow you to save your original document to an accessible 

PDF format. Creating PDFs with these programs will also save you a lot of time, 

compared to editing your PDF directly in a PDF editing program like Adobe Acrobat Pro. 

● To ensure best practices for accessibility in documents created in Google Docs (bDrive 

(link is external)), a tool called Grackle Docs (link is external) is available.  

● Before proceeding with the following tips, please review the tips for creating accessible 

Word documents earlier in this document. 

Creating Accessible PDFs from Documents 

From https://www.highline.edu/accessibility/documents/pdf-acrobat/ 

Exporting from Microsoft Office 

Microsoft Office (Word, Excel, PowerPoint) has several options for creating PDF files; the exact 
options available depend on your platform (Windows, macOS, Android/Chrome) and computer 
configuration. 

The recommended and easiest method is to choose File > Save as Adobe PDF. Other methods 
(such as printing to PDF) do not properly include all the information necessary for a fully 
accessible document. 

Exporting from Google Docs 

While Google Docs (including Sheets and Slides) allows you to download a PDF version of a 
document, the generated PDF frequently fails several accessibility checks. The recommended 
method for getting an accessible PDF from a Google Docs document is to download the 
document in Office format (File > Download > Microsoft [Word (.docx) / Excel (.xlsx) / 
PowerPoint (.pptx)]) and use Office to create the PDF file. 

Creating a PDF File 

First, you will want to make sure to follow the best practices for authoring accessible MS Word 
and Adobe InDesign documents. 

● Creating Accessible MS Word Documents 

● Creating Accessible PDFs from Adobe InDesign (link is external) 

Using Optical Character Recognition (OCR) Software 

If the original MS Word or InDesign document is not available, you may want to use a scanner or 
software program that includes optical character recognition (OCR). 

Checking the Accessibility of PDF Documents in Adobe Acrobat (Pro) 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-
accessibility.html#check_accessibility_of_PDFs 

https://webaccess.berkeley.edu/resources/tips/pdfs
https://bconnected.berkeley.edu/collaboration-services/google/bdrive
https://bconnected.berkeley.edu/collaboration-services/google/bdrive
https://www.grackledocs.com/
https://www.highline.edu/accessibility/documents/pdf-acrobat/
https://webaccess.berkeley.edu/resources/tips/word-documents
https://www.washington.edu/accessibility/documents/indesign/
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#check_accessibility_of_PDFs
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#check_accessibility_of_PDFs


To check the accessibility of your PDF document, we recommend using the following tools that 
your readers will use. Even if you do not have access to those tools, Adobe Acrobat provides an 
automated way to check the accessibility of a PDF file. The Full Check/Accessibility Check 
feature in Acrobat checks a PDF for many of the characteristics of accessible PDFs. You can 
choose which accessibility problems to look for and how you want the results reported. 

1. Choose Tools > Accessibility. 

The Accessibility toolset is displayed in the secondary toolbar. 

2. In the secondary toolbar, click Full Check/Accessibility Check. 

The Accessibility Checker Options dialog box is displayed. 

3. In the Report Options section, select options for how you want to view the results. You 

can save the results as an HTML file on your system, or attach the results file to the 

document itself. 

4. Select a page range if you prefer to check individual page 

5. Select one or more of the Checking Options. 

6. Click Start Checking. The results are displayed in the Accessibility Checker panel on the 

left, which also has helpful links and hints for repairing issues. If you created a report in 

step 2, the results are available in the selected folder. 

Because the Full Check/Accessibility Check feature cannot distinguish between essential 

and nonessential content types, some issues it reports don’t affect readability. It’s a good 

idea to review all issues to determine which ones require correction. 

The report displays one of the following statuses for each rule check: 

● Passed: The item is accessible. 

● Skipped By User: Rule was not checked because it wasn't selected in the Accessibility 

Checker Options dialog box. 

● Needs Manual Check: The Full Check/Accessibility Check feature couldn't check the item 

automatically. Verify the item manually. 

● Failed: The item didn't pass the accessibility check. 

Note: These steps pertain to features found in Adobe Acrobat DC, not Adobe Reader. 

1. Run the Make Accessible Action Wizard 

2. Add text to your document 

3. Use a document title 

4. Set the document language 

5. Add alternative text for images 

6. Add a tag structure 

7. Recognize form fields, add tooltips to form fields, and add tags to form fields 

8. Use table headers 

9. Check the reading order 

10. Check for appropriate color contrast 

1. Run the Make Accessible Action Wizard 

The Make Accessible Action Wizard in Adobe Acrobat DC will guide you through the steps of 
making your PDF accessible. Each step will prompt you to add accessibility information that may 
have been missing from your PDF. At the end of the process, Acrobat DC will run a full 

https://webaccess.berkeley.edu/resources/tips/pdfs#pdf-wizard
https://webaccess.berkeley.edu/resources/tips/pdfs#pdf-text
https://webaccess.berkeley.edu/resources/tips/pdfs#pdf-document-title
https://webaccess.berkeley.edu/resources/tips/pdfs#pdf-document-language
https://webaccess.berkeley.edu/resources/tips/pdfs#pdf-alt-text
https://webaccess.berkeley.edu/resources/tips/pdfs#pdf-tag-structure
https://webaccess.berkeley.edu/resources/tips/pdfs#pdf-form-fields
https://webaccess.berkeley.edu/resources/tips/pdfs#pdf-table-headers
https://webaccess.berkeley.edu/resources/tips/pdfs#pdf-reading-order
https://webaccess.berkeley.edu/resources/tips/pdfs#pdf-color-contrast


accessibility check of your document and will recommend further steps you can take to remediate 
your PDF. 

Adobe Acrobat Pro Action Wizard(link is external) 

2. Add Text to Your Document 

Not all PDFs actually contain text in them. If your PDF is a text-based or a searchable PDF, you 
will be able to select text in the document. If you cannot select text in your document, you have an 
image-based PDF and must use OCR tools to recognize the text in your PDF. 

Adding Text to Your PDF Documents(link is external) 

3. Use a Document Title 

The document title is important so that users of assistive technology can hear the name of the 
document when opening the file and when switching between multiple tabs within a PDF program. 

Setting the Document Title in PDF Documents (link is external) 

4. Set the Document Language 

The document language determines which speech synthesizer is used by assistive technology 
programs. 

Setting the Language of PDF Documents(link is external) 

5. Add Alternate Text for Images 

Any images or figures that convey important information in your document must have alternate 
text. Alternate text is a short description of the image that will be read out loud to assistive 
technology users. Keep your alternate text to 1-2 sentences long. 

Adding Alternate Text in PDF Documents(link is external) 

 6. Add a Tag Structure 

● Accessible PDFs must have tags. Paragraphs must have paragraph tags, lists must have 

list tags, images must have image tags, tables must have table tags etc. These tags can 

be accessed by assistive technologies and make it possible for AT users to jump quickly 

to a desired section or item in the document. 

● When using headings tags, your tags should follow an orderly heading sequence, such as 

Heading 1-Heading 2-Heading 3, not Heading 1-Heading 3-Heading 2. 

Adding / Repairing Tags in PDF Documents(link is external) 

7. Recognize Form Fields, Add Tooltips to Form Fields, and Add Tags to Form Fields 

If your PDF will be used as a form, make sure all of the form fields are recognized and are given 
an appropriate tooltip. A tooltip provides a description of the form field and is read out loud by AT 
users. Form fields also should have a form tag and appear in the correct order within the tags 
panel. 

https://helpx.adobe.com/acrobat/using/action-wizard-acrobat-pro.html
https://acrobat.adobe.com/us/en/acrobat/how-to/ocr-software-convert-pdf-to-text.html
https://www.adobe.com/accessibility/products/acrobat/pdf-repair-add-document-properties.html
https://www.adobe.com/accessibility/products/acrobat/pdf-repair-set-document-language.html
https://www.adobe.com/accessibility/products/acrobat/pdf-repair-add-alternative-text.html
https://www.adobe.com/accessibility/products/acrobat/pdf-repair-repair-tags.html


● Recognizing Form Fields in PDF Documents (link is external) 

● Adding a Tooltip to Form Fields in PDF Documents (link is external) 

● Tagging Form Fields in PDF Documents (link is external) 

8. Use Table Headers 

To ensure that tabular data are read logically by assistive technologies, use table header tags for 
column headers, row headers, or both. 

Adding Table Headers to Tables in PDF Documents(link is external) 

9. Check the Reading Order 

You will need to manually check that the content in your PDF follows a logical reading order. To 
check the reading order, open the tags panel and arrow down. Move items up or down in the tags 
panel to correct problems with the reading order. 

10. Check for Appropriate Color Contrast 

You will need to manually check that your PDF document has sufficient color contrast. We 
recommend using the free Color Contrast Analyser tool, which is available for MacOS and PC. If 
there are contrast issues in your PDF, you will need to return to the authoring program and adjust 
the colors there. 

NOTE: Any color contrast issues that are found will likely need to be addressed in the source 
document (e.g., Microsoft Word.) If you find color contrast issues in a PDF, and re-export the 
PDF, you will need to re-do all the tagging and reading order work from the above tips. 

Color Contrast Analyser (link is external) 

  

https://webaim.org/techniques/acrobat/forms#formfields
https://webaim.org/techniques/acrobat/forms#tooltip
https://webaim.org/techniques/acrobat/forms#tags
https://www.adobe.com/accessibility/products/acrobat/pdf-repair-repair-tables.html
https://developer.paciellogroup.com/resources/contrastanalyser/
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